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Is This Book For You?
Do you want to:

•  Avoid the cost of ebook conversions?
•  Have control over the look and function of your 
ebooks?

•  Create professional-quality ebooks you can be 
proud of?

If so, then this book is for you.
With the free, easy-to-use program Sigil, the savvy self-publisher can 
build an ePub for upload to retail sites such as Kobo or Apple, then make 
a few modifications to the ePub and upload it to Kindle Direct Publishing 
for conversion to Kindle. Or you can convert it yourself using Amazon’s 
free Kindle Previewer. 

Other free software can be used to test your files before you upload 
them to retail sites. If you write your manuscript in an open-source word 
processor such as OpenOffice, then even that is free.

What I love most about using Sigil is that I control the look and feel of 
my ebooks. Many conversion companies simply use template code they 
have developed for efficiency and cost-effectiveness but which doesn’t 
leave much room for creativity. If you want anything different you have to 
pay extra—if such options are offered at all. But with Sigil you can create 
the ebook you want and at no extra cost. It’s a win-win.

Even if you choose to hire out the design of your ebook, having Sigil on 
hand and understanding its basic functions means you can later make 
file changes without cost. If you find typos in your manuscript and want 
to fix them, or if you publish another book and want to add advertising 
matter to your earlier ebooks, you can do this yourself rather than pay 
a conversion company again. Modifying your files will become very 
expensive if you have to pay someone every time you need to update 
your ebook. 1

If you are an author who wishes to sell only on Amazon’s Kindle 
Direct Publishing, you can bypass learning Sigil and instead upload an 
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HTML document exported from your word processor. However, your 
manuscript will still need to be properly formatted (Chapter 1), and the 
HTML document will still need to be modified (Chapter 2). It will still be 
recommended that you convert with and test your file in Kindle Previewer 
(Chapter 3). You will find, then, that not only does uploading an HTML 
document restrict your options, but you don’t save yourself much time 
or effort over working with Sigil. And as you work through this manual 
you will find that taking that extra step into Sigil is not a difficult one.

* * *

When Amazon first launched Kindle Direct Publishing in January 2010, the 
retail giant and ebook innovator accepted just about any text document 
for conversion to the Kindle format. Problems quickly arose for users, 
who discovered that the auto-conversion method wasn’t as successful 
as Amazon claimed: many such ebooks suffered from odd formatting 
behaviour, or simply looked dreadful. These problems continue to this 
day, and in fact have increased.

Many authors then try but fail miserably to use auto-conversion tools such 
as Calibre or Smashwords’ Meatgrinder to build ePubs and mobi files. 
After tearing their hair out to no avail, these authors are often advised 
to resort to the nuclear method: save their manuscript as text only, then 
reformat the whole thing again. Needless to say, such a drastic option is 
enough to make any author of a 300-page manuscript want to cry. 

But if you use Sigil, resorting to the nuclear method will never be 
necessary: you will be able to easily find and delete any problems in your 
manuscript. The result will be a clean, stable, well-functioning ebook.

Many authors find the idea of working with HTML code to be too daunting. 
But you do not need to understand the code or how it works; you only 
need to be able to follow the directions outlined in this manual. It is a 
bit like baking: you do not need to learn chemistry to make a cake, you 
only have to follow the recipe. For the majority of text-based ebooks, the 
process is straightforward and easier than you might imagine. You will 
find, too, that the more you build your own ebooks, the less mysterious 
HTML becomes. You can even develop your own template code to create 
consistency in an ebook series, for example, or to streamline the process 
for your later ebooks.
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What You Will Need
A Word Processor
This manual assumes the majority of authors are using Microsoft 
Word. (Although Word is not free, its use is so ubiquitous that to offer 
instructions for any other word processor would be a disservice to the 
majority of readers.) Users of OpenOffice, LibreOffice, NeoOffice, Google 
Docs or Atlantis can follow the same principles indicated for Word users 
and export to HTML. With some you also have the option to export to 
ePub and fix if necessary in Sigil. Same applies to Apple Pages, which 
can export to ePub but not HTML. Users of Scrivener will need to export 
to text and import into a word processor because Scrivener does not 
support styles (and the ePubs it makes are not industry standard).

Instructions herein refer to Word 2013 for PC. I chose this version 
because it is neither the latest, which most users rarely have, nor the 
oldest, which most users have by now abandoned. And if you regularly 
update your copy of Word, many of the options update as well, so you 
should easily be able to follow the instructions herein. Earlier versions 
of Word for PC have equivalent functions, as do Word for Mac and other 
word processors. Tinker with your program as necessary.

HTML Editor (optional)
If you decide you only want to go the HTML-to-Kindle route, you will need 
an editor such as Notepad (PC), TextEdit (Mac), or the open-source HTML 
editor KompoZer. None of these will be necessary if you work in Sigil.

Sigil
Sigil is best downloaded from its official host, GitHub (see links at end of 
chapter). Sigil can also be found on third-party websites, but I strongly 
advise that you do not download from these sites: they often add malicious 
code such as adware, or they bundle Sigil with a trial version of another 
program you don’t want or need. Downloading from GitHub also ensures 
you have the latest release.

Note that you will only need the actual Sigil program, not any of the 
developer files; you only need the Mac-Package, Windows-Setup, or 
Windows-X64-Setup file, whichever is appropriate for your system. Note 
that, as an open-source software, Sigil is updated often as new features 
are added or bugs are found and fixed. Thus you may find that something 
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has changed slightly from what you see in this manual. If you need further 
help, there is an excellent forum on the website MobileRead dedicated 
to Sigil.

ePub Validator
For validating your ePubs, you can use the online validator at the 
International Digital Publishing Forum (IDPF), but I find using Pagina’s 
free EPUB-Checker to be a quicker and easier solution. Importantly, EPUB-
Checker does not require an Internet connection when you use it, and it 
handles files larger than 10MB, a restriction of the online validator tool.

ePub Apps
For testing ePubs, you can use Adobe Digital Editions (ADE) or any of the 
many other free ePub apps available. I like to use ADE in my computer 
for initial testing, then I use Aldiko for Android on my tablet. I finish with 
my Kobo device and apps. Apple computers and tablets have the built-in 
iBooks reader. There are ePub apps for many browsers such as Firefox or 
Chrome.

There are a number of ePub apps for smartphones, whether Android  
or iOS. When choosing which apps to use, make sure ePubs can be 
sideloaded directly into your phone or downloaded to your device via 
Dropbox or your Google account, to cite two examples.

Kindle Previewer and Reading Apps
For conversion and testing for Kindle, you will need to download Kindle 
Previewer 2.94 from Amazon. At time of writing, Amazon were beta-
testing Kindle Previewer 3, which includes their Enhanced Typesetting 
features. I recommend you install both versions on your computer and 
test in each. You can also download the Kindle for PC (or Mac) app and 
test there. For mobile previews, download the free Kindle app for your 
phone’s operating system. 

Kindle Previewer replicates (though not perfectly) the display behaviour 
of the latest Kindle devices. It will also create a Kindle for iOS file, but you 
cannot view it in Previewer; it must be sideloaded onto an Apple device. 
For publishers on PC who do not own an Apple device, you have to go on 
faith or ask someone with an Apple device to test for you.
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eBook devices and apps rarely function identically, even from the same 
manufacturer. For example, a Kindle device and Amazon’s Kindle for PC 
app do not contain all the same functions and do not display identically. 
It is recommended that you test your ebook in as many devices and 
apps as is possible within your budget.

Links
Sigil  
https://github.com/Sigil-Ebook/Sigil/releases

Adobe Digital Editions 
http://www.adobe.com/solutions/ebook/digital-editions/download.
html

Kindle Previewer 
https://www.amazon.com/gp/feature.html?docId=1000765261

Kindle for PC/Mac 
https://www.amazon.com/gp/digital/fiona/kcp-landing-page/ref=kcp_
ipad_mkt_lnd

IDPF online validator 
http://validator.idpf.org/

Pagina EPUB-Checker 
https://github.com/IDPF/epubcheck

Sigil forum on MobileRead.com 
https://www.mobileread.com/forums/forumdisplay.php?f=203

All links are valid as of writing but may change in the interim. If so, a 
quick online search will bring them up.



eBook Development
Ever since the inception of their ebook retail division, and the launch of 
Kindle Direct Publishing, Amazon have remained committed to developing 
a proprietary format, the Kindle, and to manufacturing format-specific 
Kindle devices; the Kindle is thus both an ereader device and a file format. 
Kindle books have the file extension .azw; the AZW file is a variation of 
the older mobi file, which is a variation of the PRC file first developed by 
Mobipocket Creator (which Amazon purchased). Kindle devices and apps 
will thus read all three files: AZW, mobi, and PRC.

In contrast to Amazon’s Kindle, the rest of the tech industry has been 
primarily devoted to the open-source ePub format, which is sold on all 
other ebook retail sites outside of Amazon. Very early on the ePub was 
way ahead of Kindle in terms of features, allowing, for example, the 
inclusion of embedded fonts, drop caps, colored text, bulleted lists, text 
boxes, right margin indents and so on that Kindle books did not.

Amazon’s response to this was Kindle Format 8 (K8). K8 brought the 
Kindle into the same league as the ePub, but this created two problems 
for publishers: 1) older Kindle (mobi7) devices could not read K8 code; 
and 2) the code produced for these K8 features in programs such as Word 
was simply incompatible with K8 devices.

Amazon addressed the first issue with media queries—additional code 
that allows the publisher to create different versions of their ebook 
in a single file—but such files could not be created by Amazon’s auto-
conversion process. Publishers whose ebooks required media queries 
had to learn a new skill or pay an ebook designer.

Amazon have never really addressed the second problem, mainly because 
they cannot change the code in Word or any other word processor. 
Instead, Amazon continue to accept text documents for auto-conversion 
while simultaneously discouraging authors from submitting them, which 
has resulted in contradictory directions on the KDP website.

The truth is, as Amazon rushed to develop K8, the differences between 
the proprietary Kindle and the open-source ePub became less and less 
marked. Now, for text-based ebooks (such as novels), the only real 
difference between the two formats is a few lines of code.
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Where the ePub and Kindle formats do differ dramatically is in image 
handling. Adding internal images to a Kindle book is far easier than adding 
them to ePubs. For the typical author self-publishing an ebook with only a 
cover image, this issue will not arise. Consequently, I have separated this 
manual into standard and advanced formatting techniques, saving the 
more complex but less common techniques for the latter section.

Because the ePub format is open source, companies are free to modify 
it as they wish and to use the code as the basis for proprietary formats 
such as Apple’s iBooks Author format or Nook’s Kids Book Builder. Device 
manufacturers also create quirks in their device programming to force 
publishers to build retailer-specific files, which in turn forces consumer 
loyalty to a retailer’s catalogue and devices. Where applicable these 
differences are discussed in this manual.

Characteristics of eBooks
An ebook appears on your computer as a single file but it is actually what 
is known as an archive, a zipped folder containing separate subfolders and 
files. These subfolders and files contain the ebook’s text, images, fonts 
if embedded, stylesheet(s), and metadata, and to which ebook retailers 
add code for such things as digital rights management (DRM).

When talking about ebooks, you will always hear references to HTML. 
HTML is the language of the Internet; it is what web pages are built upon. 
Another coding language, XML, is a document mark-up language designed 
for encoding documents intended to be read across the web. XHTML is a 
combination of the two and is what ebooks are built upon. 

There are essentially three types of ebooks on the market now: reflowable, 
fixed layout, and PDF.

Reflowable eBooks
Reflowable ebooks require different formatting than print books because 
ebooks do not have fixed margins, page length, or font size. Instead, the 
font is scalable—meaning the user can adjust the font size on their device 
to suit their reading preference—and thus there is no fixed placement of 
the text on the screen; the text simply flows through. Also, each device 
has a different screen size so you cannot design to a specific digital “page,” 
and some devices allow users to adjust the white margins around the text.
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Consequently, in reflowable ebooks there are no page numbers, though 
some devices can display “page” markers so the ebook can be quoted 
and properly referenced as a print book can be. Page markers are added 
by the reading device, so you needn’t worry about adding these to your 
document.

Reflowable ebooks are the preferred format for novels and other text-
based ebooks. While reflowable ebooks often contain images, the text 
is dominant. The majority of self-published authors release reflowable 
ebooks, of which there are two formats: Kindle and ePub.

The Kindle Format
The older Kindle mobi7 format is all but phased out, and many publishers 
simply no longer accommodate consumers still using older Kindle devices. 
That said, there are many still out there, and thus some publishers still 
use media queries to satisfy these consumers. If you are releasing a 
novel or similar, media queries will not be necessary. For publishers with 
more complex ebooks, the code for adding media queries is illustrated in 
“Advanced Formatting.”

As already indicated, Kindle Format 8 allows for more advanced formatting 
than mobi7. We will thus be focusing on K8, indicating issues with mobi7 
only where applicable.

There is a new format, Kindle Format X (Ten; extension .kfx). KFX is a 
whole new Kindle format, based on Javascript instead of XHTML. Amazon 
convert existing ebook formats into this new proprietary format, and as 
such publishers must still produce ePub, mobi, or HTML files, using the 
formatting found in this manual, for upload to Amazon.

KFX books are not compatible with older mobi7 or mobi8 devices, of which 
there are literally millions in the hands of consumers. These consumers 
will have a K8 or mobi7 version of your ebook sent to their devices.

At time of writing, KFX is still in the beta stage and is not being applied 
equally to all new ebooks because KFX does not yet support all features 
found in K8. Critics have complained that KFX formatting has been 
applied—without notification to publishers—to tens of thousands of 
ebooks already on sale, sometimes with adverse effects. eBooks available 
in KFX show “Enhanced Typesetting: Enabled” on the ebook’s product 
page. 
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KFX also includes a new encryption method to prevent Kindle books from 
being converted to other formats in software such as Calibre (at least 
until Calibre’s developers, and others like them, figure out the code). This 
applies even to ebooks not DRMed by the publisher. Critics believe this is a  
strategy to force consumer compliance to Kindle devices and apps.

ePub2 Versus ePub3
The ePubs created by Sigil are the ePub2 format, based on HTML4 and 
CSS2. ePub3 uses HTML5 and CSS3, the next-generation code. Kindle 
Previewer (Kindlegen), which converts ePubs to the Kindle format, will 
accept both ePub2 and ePub3 files but cannot read all ePub3 elements. 
Uploading ePub3 files to Amazon is therefore not recommended.

For the publisher releasing a reflowable ebook, ePub3 is not required. 
More importantly, ePub3 devices are backwards compatible but ePub2 
devices cannot read ePub3 files. So unless your ebook requires ePub3 
code, producing an ePub3 ebook will impede your sales efforts. This 
manual, like Sigil itself, thus limits itself to ePub2.

Fixed Layout eBooks
Fixed layout ebooks contain static pages where the text and images are 
fixed and cannot be changed by the end user. Fixed layout ebooks often 
contain pop-up text boxes, or the reader can zoom in on graphics or text. 
Some fixed-layout formats can also contain other media such as video or 
audio files; if so, these are called rich media ebooks. Fixed layout ebooks 
are the preferred format for image-centric ebooks: comic books, graphic 
novels, children’s books, cookbooks, and some textbooks.

Amazon have developed free software for building fixed layout ebooks 
for Kindle: Kindle Kids’ Book Creator, Kindle Comic Creator, and Kindle 
Textbook Creator.

Apple’s version is the free iBooks Author, a proprietary format (.iba) 
built on a modified ePub. iBooks Author files can only be built on Apple 
computers, sold through the Apple iBookstore, and read on Apple devices.

Barnes & Noble have also developed a proprietary children’s ebook 
software, Nook Kids Book Builder, which, like iBooks Author, creates 
modified ePubs. Children’s Nook books can only be sold on B&N and read 
on Nook devices.
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Retailers who have produced software for fixed layout ebooks require 
that such ebooks be built in their proprietary software or they cannot be 
sold on the retailer’s site. As such, fixed layout ebooks are not covered by 
this manual.

PDFs
Adobe PDFs have been around for ages, but in the early days of ebooks the 
PDF format was rejected for its poor quality on the small, low-resolution 
screens of the early ereaders. With the advent of larger, higher-resolution 
tablet screens, PDFs are making a comeback for their close proximity 
to the print book, and are popular with libraries. However, there is not 
yet wide distribution of PDFs, and most of the major ebook retailers—
Amazon, Apple, B&N, Kobo—do not sell the PDF format. As an indie 
publisher you will likely only encounter the PDF if you opt also to sell a 
print version of your book or have access to library distribution.

Language Options
Amazon currently accept ebooks published in Afrikaans, Alsatian, Basque, 
Bokmål Norwegian, Breton, Catalan, Cornish, Corsican, Danish, Dutch/
Flemish, Eastern Frisian, English, Finnish, French, Frisian, Galician, German, 
Icelandic, Irish, Italian, Japanese, Luxembourgish, Manx, Northern Frisian, 
Norwegian, Nynorsk Norwegian, Portuguese, Provençal, Romansh, Scots, 
Scottish Gaelic, Spanish, Swedish, and Welsh. eBooks published in other 
languages will be removed from sale.

The ePub2 format can display any language that is read left to right and 
horizontal. Right-to-left and vertical languages usually require ePub3 
files, and as such are not covered in this manual. And although the ePub 
format has wider language support than Kindle, not all retailers accept 
all languages. For example, while Kobo accept most languages, Apple sell 
only ebooks in English, Arabic, Catalan, Chinese, Croatian, Czech, Danish, 
Dutch, Finnish, French, German, Greek, Hebrew, Hungarian, Indonesian, 
Italian, Japanese, Korean, Malay, Norwegian, Polish, Portuguese, 
Romanian, Russian, Slovak, Spanish, Swedish, Thai, Turkish, Ukrainian, 
and Vietnamese. If publishing in a “global language” (read: non-Latin 
alphabet), check first with the retailers you wish to sell through. 

An ebook in a global language almost always requires the publisher to 
embed the necessary font to display all foreign characters correctly. Font 
embedding is covered in “Advanced Formatting.”



1  Format Your Manuscript
Authors who follow these formatti  ng guidelines will create a manuscript 
that will be much easier to convert to the ePub and Kindle formats, and 
one that is much less likely to produce common errors that degrade the 
quality of your ebook.

Most of you will be reading this aft er you have already writt en your 
manuscript. Don’t worry: much of what I am writi ng here can sti ll be 
applied aft er the fact. If not, you will be able to fi x things later in Sigil. That 
said, the more you can do to clean up your manuscript before importi ng 
into Sigil, the less work you will have later.

 Language Settings
In your Word opti ons, under the Language tab (File > Word Opti ons > 
Language) is the ability to Choose Editi ng Languages. (You can also access 
this via Review > Language > Language Preferences.) In the dialogue box 
that opens you will fi nd the default editi ng language already installed. The 
default in copies of Word shipped in North America is “English (United 
States)”. Beneath this is an opti on to add more editi ng languages, and a 
butt on to set your default editi ng language from among those specifi ed 
in the box (Fig. 1.1).

In your Word document itself you have the opti on to set the proofi ng 
language (Review > Set Proofi ng Language). This sets the default language 
of the Normal style within your document and, if you choose, the default 
Word template (Fig. 1.2). 

Fig. 1.1
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When your Word document is 
later exported to HTML, in it 
will be a line of code that states 
which language your document 
is written in. Contrary to logic, 
this code is determined by 
the default editing language 
in your Word options, not by 
the proofing language of your 
document. The code will thus 
always be <body lang=EN-US> 

if you have a North American version of Word and have never changed 
the default editing language. 

A problem arises if the proofing language of your document differs 
from your default editing language. If so, then Word creates a formatting 
override (“inline styling”) for the Normal style in your document. 
Since all ebook styles must be based on the Normal style, this creates 
an override in every paragraph of your manuscript, otherwise known 
as bloated code. For example, if your editing language is the default 
U.S. English but your document language is UK English, you will find 
<span lang=EN-UK> in every paragraph of your document. If you are 
writing in French you will find <span lang=FR>, and so on for other 
languages.

When you later build your ebook in Sigil, you will specify your ebook’s 
language in the metadata, which will tell the ereader device what 
language your ebook is written in. However, both the language code and 
the inline styling created by Word will remain unless you remove them. 
The first is easy to delete (it’s only one line of code) but the inline styling 
found in every paragraph will be tedious to remove. While it may not 
harm your ebook, I’m of the opinion that the cleaner your code the more 
stable your ebook. So this is best fixed at the outset, and it is easy to do.

To fix the problem, you need to synchronize the primary editing language 
in your Word options with the proofing language of the Normal style in 
your document:

1. First ensure your default editing language in your Word 
options is the same language your document is written 

Fig. 1.2
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in. If not, change as appropriate.

2. If you changed the default editing language, close then 
reopen Word to put the change into effect.

3. Open your manuscript, select all text (Ctrl+A) and set 
the proofing language to match (even if it was correct to 
begin with). This will erase from your manuscript code 
any previous language overrides.

The flip side to this is that if you use foreign words or phrases in your 
ebook, you can set the language just for those words or phrases by 
highlighting them and then selecting Review > Set Proofing Language. 
This will create an inline language style just for the select text. If the user 
then clicks on a foreign word, some ereaders will then open this secondary 
dictionary instead of the primary language dictionary. The definition will 
be in the foreign language, too, though—the ereader will not translate—
but this mechanism can be useful for multilingual consumers who may 
simply not be familiar with the foreign word(s) you have used. I am 
hoping that in future we will see translation dictionaries in ebooks, which 
will benefit from this technique.

Document Properties
Word offers the option to include in your document metadata your 
author name, document title, subject, keywords, category, status, and 
comments; you access this by selecting File > Info. The author name is 
automatically filled in with the name of the program user (as set in your 
operating system); the remaining fields are blank and should be left that 
way. If not, delete any field entries.

Document Set-Up
Set your document to a single page size applied to the whole document. 
Do not split your document into sections that are formatted differently. If 
you already did this, remove the section breaks.

Page margins are irrelevant, so you may set your margin width as you 
wish. However, the same margins must be applied to the whole document. 
If you set different margins partway through your manuscript, you will 
inadvertently create a section break.

Turn off most AutoCorrect options: File > Proofing > AutoCorrect Options. 
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Then, under tabs for both/either AutoFormat and AutoFormat As You 
Type, uncheck: “Automatic bulleted lists”, “List Styles”, “Ordinals (1st) 
with superscript”, “Border lines”, “Automatic numbered lists”, “Tables”, 
and “Set left- and first-indent with tabs and backspaces”. Left as is, many 
of these AutoCorrect options will later cause you grief.

There are no page numbers in ebooks, no header or footer information. 
If you used these in your manuscript, remove them.

You will later use Sigil to build your table of contents. If you used your 
word processor’s table of contents module, or if you built a table of 
contents by hand, remove it.

The Importance of Using Styles
Most authors who use Word do not use custom styles; instead, authors are 
in the habit of using the default Normal style then using the tab key and 
formatting toolbar to create headings or different styles of paragraphs. 
Unfortunately, not only are tabs not recognized in ebooks, but the habit 
of simply overriding the Normal paragraph results in a very poorly coded 
ebook, one that can be unstable when viewed on different devices. 

When you modify text, the paragraph is still defined by its primary style 
and then additional information is generated that indicates the changes 
made. For example, if you modify a line of Normal text to create a chapter 
heading by increasing the font to 18 points and centering the text, in your 
Styles window you would find “18pt, Centered” added to your list.

(In older versions of Word, a plus sign [+] is added to the style in use, 
followed by the modifications made. For example, in the list of styles in 
use in your document, Normal would be indicated by the ¶ symbol and 
the modification would appear below it as “Normal+ 18 pt Centered”. In 
newer versions of Word, the plus sign is added only to styles other than 
Normal.)

The problem with using this method is that such paragraph modifications 
are translated into inline text styling when you export to HTML, and this 
inline styling can create havoc in your ebook.

More importantly, ebooks use what is called a Cascading Style Sheet 
(CSS) to format the different paragraph styles and headings contained 
within your ebook. When you later convert your manuscript to HTML, 
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the styles you use in your word processor will form the basis of your CSS; 
if you do not use styles, it will be much more difficult to build your ebook. 
The sooner you embrace styles the sooner you will be on the road to 
creating a more professional manuscript and a more beautiful ebook. 
If you have already finished your manuscript and did not use styles, do 
not fret: you can create your styles now and then apply them to your text.

Creating Styles
A style is akin to a recipe: it says this style 
equals whatever combination of font and 
paragraph formatting you input. Styles can be 
quite specific to include any possible paragraph 
formatting from font type and size to paragraph 
alignment and indentation and Before/After 
values, and so on. The beauty of styles is that if 
you later decide to modify your document, you 
merely have to modify the relevant styles rather 
than go through your 300-page manuscript. 
For example, if you have a chapter heading 
style that has an After value of 24 points and 
you later think this is too little, you can change 
the After value in the style to, say, 36 points 
and every chapter heading that uses that style 
will automatically be adjusted without affecting 
other text not based on that style, such as your 
body text.

Word has a number of default styles, the most obvious one being Normal, 
but also various default heading styles, a hyperlink style, a footnote style, 
and so on. You can create your own styles to suit your document or you 
can modify the default styles.

To modify a default style, click on the Styles submenu on the toolbar to 
open the Styles dialogue box (Fig. 1.3). In the list that appears, pick the 
style you want to modify; in this example we are modifying Heading 1. 
Hover over the ¶ª symbol; it will change to an arrow. Click on the arrow 
and select Modify from the drop-down menu that appears. 

In the Modify Style dialogue box that opens (Fig. 1.4), set your basic 
attributes: font family (Times New Roman, for example), font size, 
font style (Bold, Italic), font color (use Automatic for black), paragraph 

Fig. 1.3
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alignment, and line spacing (always use Single). 
If you check the box “Add to the Styles gallery”, 
Word will add the style to the options that appear 
in your toolbar (if the style is not already there). 
Never check “Automatically Update”.

Although this initial dialogue box also gives you the option to adjust 
before/after margins and left/right indents, this is better done in the 
Paragraph dialogue box. While still in the Modify Style box, click on the 
Format button in the lower-left corner. A number of options will appear. 
Click on Paragraph. Here you can adjust the spacing and margin indents, 
create a first-line indent or hanging paragraphs (Fig. 1.5).

You can also create your own styles. To create a new style, in the 
Styles box click on the New Style icon (the first of the three icons 
in the lower-left corner, Fig. 1.3). Input your new style’s attributes.  
NOTE: all styles must be based on Normal. Give the style a name and 
click OK.

Fig. 1.4
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You may find as you 
reformat your manu-
script that it can be 
very useful to click 
on the Options but-
ton in the lower right-
hand corner of the 
Modify  Sty le  box 
and, in the next box 
that opens, select “In 
Current Document” 
under “Select styles to 
show:” (Fig. 1.6). This 
reduces the lengthy 
“All styles” list down 
to a more manageable 
one. You will also find 
it helpful to check the 
boxes for “Paragraph 
level formatting” and 
“Font level format-
ting” and “Show next 
heading when previous 
level is used”, and then 
select “Only in this docu-
ment”. Leave all other op-
tions unchecked. Click OK 
to close.

Applying Styles
To change a paragraph 
or heading’s style, simply 
place your cursor any-
where in the paragraph 
or heading and click on the 
style you wish to change 
to. This will apply the new style to the paragraph or heading.

If you already used styles in your manuscript, you may find that you only 
have to make a few changes to your styles in order to accommodate the 
general formatting principles outlined in this chapter. 

              Fig. 1.5 (top) and Fig. 1.6 (bottom)
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If you have not used styles in your manuscript, and you used the Normal 
paragraph throughout, the quickest route is to modify the Normal style 
to create a line break (if wanted) or to eliminate issues such as tabs. Then 
reformat your headings and any special paragraphs. Delete any unwanted 
line breaks created with a carriage return, and delete any tabs. Both can 
be quickly accomplished using Search & Replace.

WARNING: If you modify the Normal style to include a first-line indent, 
remember to remove that indent when you format your heading and 
other styles.

WARNING: When you convert a paragraph to another style, some versions 
of Word will erase text effects such as Italic or Bold. Sometimes Italic is 
erased but Bold remains; other times the formatting remains if only a 
portion of the paragraph has been modified, while erasing all formatting 
if the whole paragraph is modified. Sometimes Word will convert the 
paragraph to the new style but keep an override such as font size even 
though Word erases every other override. It’s a real mishmash. Be mindful 
of this when converting a paragraph from one style to another.

Heading Styles
Your chapter heading should be created with Heading 1. Your first 
subheading should be Heading 2, and the subheading of Heading 2 should 
be Heading 3, and so on. This is because when you later build your table 
of contents (TOC) in Sigil using its automated module, it is programmed 
to recognize these headings and will cascade them for you in ascending 
order:

(Chapter) Heading 1 
 (Sub) Heading 2 
     (Sub) Heading 3

Sigil allows you to edit the TOC manually, but by using the headings as 
intended you avoid the work you will otherwise have to do to build your 
TOC. What I usually do is use Heading 1 for my chapter headings; if I want 
to format other page headings such as Acknowledgements, About the 
Author, and so on, differently from my chapter heading, I use a different 
style and then manually add these entries to my TOC later in Sigil.

WARNING: Do not use Heading styles on your title page. If the end 
user turns off publisher formatting (discussed in more detail in the next 
chapter), most ereader apps are programmed to treat any Heading 1 and 
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Heading 2 entries as chapter headings and may add a page break before 
them.

Character Styles
Character styles can be created in the same way as paragraph styles: open 
the Styles box and click on the New Style button to open the options 
box. Give the style a name, and in the field beneath, Style Type, open the 
drop-down menu and select Character. You will then see that paragraph 
formatting options are grayed out, leaving you only font options to choose 
from.

To apply a character style, highlight the relevant text and then click on 
the style.

WARNING: Never create a character style that involves changing the font 
size. For inexplicable reasons, Word creates the style but then uses inline 
styling for the font size. It makes no sense, and you will just have to fix the 
mess later in Sigil. If you want to create a character style that changes the 
font size, you will have to do it later in Sigil. This is covered in “Advanced 
Formatting.”

WARNING: Do not use a character style to create drop caps. Drop caps 
must be built by hand later in Sigil: the code Word creates does not display 
properly in ebooks. Drop caps are covered in “Advanced Formatting.”

Emphasis and Strong
Two default character styles in Word that you may find useful are 
Emphasis and Strong. Emphasis by default italicizes the text, and Strong 
bolds the text. However, they create different code than Italic or Bold, and 
this code is interpreted by Text-to-Speech (TTS) software differently than 
Italic and Bold. TTS software is used to read your ebook aloud to the user, 
though few ebook devices have this option. (Some older Kindles do, and 
there are apps available for Windows, Android, and iOS.)

In theory, Emphasis (<em>) tells the TTS reader to emphasize the text, 
as in “Get out—Now!”; Italic (<i>) is used for foreign words, interior 
dialogue, titles of books, and so on, and is read in a normal tone.

Similarly, Strong (<strong>) is used to bold text and is pronounced more 
forcefully by the TTS editor than Emphasis. You might use it, for example, 
in “The sign said ‘Danger—Keep Out!’”
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Now, I say “in theory” for two reasons: 1) some TTS software is program-
med to emphasize all italicized text, which defeats your efforts; and 2) 
in HTML5, <strong> no longer means “strong emphasis” but now 
simply means “important”. So it all depends on how the TTS software is 
programmed. That said, it certainly doesn’t hurt to put in the code for 
those TTS readers that are programmed as expected.

Emphasis and Strong (or Bold) can be used together to create emphasized 
Bold Italic text. They can also be further controlled through classes when 
you create your ebook in Sigil. This is covered in “Advanced Formatting.”

Fonts
When you export to HTML, and your styles are translated into CSS, each 
style will specify which font you used for that style; this is called a font-
family attribute. However, ebook devices are limited in the fonts they 
have installed, no two devices have the same fonts installed, and thus 
most are not able to display the font your code indicates. The result is 
that ebooks have been developed based on the user selecting which font 
they wish to read your ebook in, chosen from among their device’s or 
app’s options, rather than the font you wrote your book in.

Amazon no longer want font-family attributes included at all in Kindle 
files because this can interfere with the user’s ability to choose their 
preferred font. Consequently, regardless of which font you use, you will 
delete this information when you build your ebook. Choosing a font for 
its look is therefore pointless. With ePubs the same principle applies.

For ease of use, I format my manuscripts in Times New Roman because 
it contains recognized text effects and the Windows-1252 character set, 
both discussed below.

If it is essential that your ebook display more than one font, or a specific 
font, that font can be embedded in your ebook. Font embedding is 
covered in “Advanced Formatting.”

Text Effects
Digital devices in general will recognize Italic, Bold, Superscript, 
Subscript, and Strike-through text effects. All other text effects cannot 
be read and will be converted to Regular text. This includes Double Strike-
through, Shadow, Outline, Emboss, Engrave, Small Caps, All Caps, Hidden 
Text, Horizontal Scaling, Raised Text, and Lowered Text.
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Underline is now a special case as the code for it (<u>) has been 
deprecated (rendered obsolete) in ePub code. To create underlined text 
you now must create a character style. Creating a new character style for 
Underline is covered in “Advanced Formatting.”

(Although the code for Underline will still be read by pretty much every 
ereader out there, using <u> will cause your ePub to fail validation, an 
essential step to putting your ebook on sale.)

If you need underlined text that will not easily be found without later 
digging through your manuscript line by line, use Word’s Underline 
feature for now so as to create an easily found bit of code, but know that 
it will have to be replaced later.

Both Superscript and Subscript will cause odd line spacing in ebooks, 
and thus the trend is to use them only when necessary, such as in 
mathematical concepts. So instead of writing “1st” one simply writes “1st”. 
If you have an AutoCorrect option set to change ordinals to superscript, 
I recommend you turn it off.

Text Characters
Amazon have focused on languages that use the Latin alphabet. This is 
why you will find on the Kindle Direct Publishing website a directive to use 
only Latin-1 characters. This is actually a bit misleading since Kindle books 
will in fact read all characters found in the Windows-1252 character set 
(Fig. 1.7), which incorporates Latin-1 and also the subsets Basic Latin, 
General Punctuation, and a handful of characters from Latin Extended-B. 
Windows-1252 is also known as Western European (Windows).

Fig. 1.7


